Volunteer Scheduler Pro
Quick Start Guide
Introduction
Welcome to Volunteer Scheduler Pro! This Quick Start Guide will guide you through the process of
creating schedules, publishing opportunities and filling shifts in just a few easy steps. We recommend
that you print out this guide by choosing “Print…” from the File menu and read it through while you
get started with VSP.
We also have guides available Salvation Army Kettles, Adoration, or events.

Step 1: Entering your jobs
The first step to getting started with VSP is to specify the jobs you will be scheduling. A job is any task
or role that is performed by your volunteers at any of your shifts. For each shift, you will be able to
specify how many volunteers in each job should be scheduled.
To create a job, first click on the Jobs pane on the left hand side of VSP’s main screen (the screen
which appears when you launch the program). Then click the “New Job…” button. In the dialog that
appears enter a name for the new job (e.g. “Receptionist”, “Usher”, etc.).
There are several options available on the left hand side of the dialog that affect how positions in the
job appear and are scheduled. These options include separating the job into multiple “subdivisions”,
numbering positions in the job, scheduling the same volunteer for the job for a week at a time, and
more. These options are not discussed in this Quick Start Guide, but you may click on them inside VSP
to see a short explanation of what each option does.
For the purposes of getting started with VSP, just enter the name of the job in the “Name” field, and
then click OK. Then click the “New job...” button again to repeat this process for each job you will be
scheduling.

Step 2: Creating a schedule and shifts
After you've entered all your jobs, click on the Schedules pane on the left hand side of VSP's main
screen and enter the start and end dates for a schedule. Clicking the calendar icons to the right of the
fields will produce calendars from which you can select the dates. After you have entered your
schedule’s start and end date, click the “Create…” button. A window will open that contains a blank
schedule spanning the date range you specified. Note that all the shifts and jobs that will occur within
this time period will be included on this “master schedule.” Don’t worry, you can optionally print or
post online separate “views” of the master schedule, by date, job or shift. Check out this resource for
more information on creating separate live schedule posts.
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Now you'll want to create your shifts. Click on a day in the
calendar on which one of your shifts take place, and then click
the “New Shift...” button at the top of the window.
In the dialog that appears, set the start and end time for the shift
by clicking on the hours or minutes and typing in the correct
value – or by using the arrows next to each value.
If the shift repeats on other days of the week, or monthly or
yearly, use the controls under the “Repeats:” heading to set up
the appropriate repeating pattern. The other instances of this
shift will automatically be created for you, both in this schedule
and in your future schedules.
Next, specify how many volunteers from each job are required
for this shift. Select a job from the list by clicking on it and then
type the number of required volunteers for that job. (You can
also use the arrows that appear below the job list to adjust this
number.)
Once you have configured this shift for the correct times, days, and required jobs, click OK. Then
repeat this process for all your other shifts. When you have finished creating all your shifts, choose
“Save” from the File menu at the top of the schedule window. A dialog will open asking you to enter a
name for the schedule. Be sure the box is checked to “Make this schedule live now” and select the
option to “Just use the default layout and options for now,” and then click OK.

Step 3: Entering your volunteers
Now that the schedule is saved, it’s time to get your volunteers into the database. There are three ways
to do so:
1. Import existing volunteers’ contact information from a .csv (Excel) or .txt file. For help
importing volunteers, please refer to this article in VSP’s Complete Documentation.
2. Email your organization’s enrollment form to a list of contacts. As people enroll, they are
added as volunteers to the database. See below for more information.
3. Enter your volunteers’ information manually one volunteer at a time. See the section below
for information on manually entering volunteers.
Using the Enrollment Form
VSP’s enrollment form is an online form that potential volunteers fill out to be added to your
organization’s VSP database. To see the enrollment form, click on the Web Terminal pane on the left
hand side of VSP's main screen. At the top of the pane, click “Web Terminal Settings” and then click
the Enrollments pane on the left. The Enrollment URL at the top is the direct link to your form, which
you can send to volunteers.
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Click on your Enrollment URL to see how volunteers will go through the enrollment process. Your web
browser will open to the default enrollment form. When volunteers fill out this form and click submit,
you will see a record of their enrollment appear in the Web Forms pane of VSP. By default, enrollment
forms need to be manually processed by you or another VSP administrator (you can alternatively turn
on automatic processing if you prefer not to have to approve each enrollment). When an enrollment
form is processed (either manually or automatically), the following will occur:
•
•
•

The volunteer appears as an active volunteer in the Volunteers pane.
The volunteer will receive an email confirming their enrollment form was processed, and
providing information on how to log in to the Web Terminal to sign up for additional shifts,
update their profile, and more.
If you allow volunteers to sign up for specific shifts during enrollment, the volunteer is placed
in the shifts they selected, which you can verify by opening the schedule from the Schedules
pane on the left hand side of VSP's main screen.

Now that you've seen how the enrollment process works, let's take a look at how it can be customized
for your organization's specific needs. You can control which information to collect by going to the
Web Terminal pane on the left hand side of VSP's main screen, and clicking the “Web Terminal
Settings” button at the top of the Home tab (note that the Web Terminal Settings dialog is not accessible
in the 15 day free trial of VSP). Click the Enrollments pane on the left, and a number of subheadings
will appear below it. Each heading controls one section of the enrollment form. Using these controls,
you can:
•
•
•

Customize the information requested during enrollment.
Enter descriptions for your jobs to be displayed on the enrollment form.
Customize the text of the enrollment confirmation email.

Manually entering volunteers
Click on the Volunteers pane on Volunteer Scheduler Pro’s main screen and then click the “New
Volunteer…” button for each volunteer you are scheduling. Enter the first and last name of the new
volunteer, and add his or her email and contact information. You can create and enter values for custom
fields by clicking the “Edit custom fields...” button. Select the jobs the volunteer is qualified in using
the “Job qualifications” list in the top right corner of the dialog.
The rest of the settings on the right hand side of the dialog are used to track volunteer availability and
preferences. You will not need to use these sections if you are primarily having volunteers sign up for
shifts online. You will only need to use the “Shift preferences” and “Preferred serving frequency”
sections if you are using the availability based rotation model. (See Appendix A for a discussion of the
three common volunteer scheduling models.)
When you are finished editing this volunteer’s profile click the OK button. (For a detailed explanation
of all the options available in the Edit Volunteer dialog, refer to VSP's Complete Documentation.)

Step 4: Scheduling volunteers
3

Once you have created your schedule and imported/entered volunteers, you are ready to start
scheduling volunteers. There are four methods that can be used to schedule volunteers.
1. Volunteers sign up for shifts online
2. You manually add volunteers to particular shifts
3. You set up repeating scheduling patterns for volunteers (Fri, 9:00 AM every other week)
4. You use the auto-scheduler to fill in shifts automatically based on volunteers' availability
With VSP, you may use any combination of these methods. Which methods you use most will depend
on the scheduling model used by your organization. (See Appendix A for a discussion of the three
common volunteer scheduling models.) We'll walk through how to use each of these methods in order.
Volunteers sign up for shifts online
To see how volunteers will sign up for shifts online, click on the Web Terminal pane on the left hand
side of VSP's main screen, and click the “Login as...” button. Choose a volunteer to login to the Web
Terminal as if you were that person. Once you are logged in, click on the “Full Schedules” tab at the
top of the page, and then click on an unfilled position to sign up for a shift (note that the volunteer you
are logged in as must be qualified in the job to be able to sign up for the position). Once you submit the
request, go back into VSP (minimize or close the web browser window), and click on the Web Forms
pane on the left hand side of VSP's main screen. You'll see an “Assignment form” in the list that
represents the assignment request you submitted online. To actually make the assignment in the
schedule, select the form and click the Process Form button. (You can also set up these forms to be
automatically processed, so the assignments are made in real time as soon as the forms are submitted.)
When you are ready to introduce VSP to your volunteers, you will email them a link to the Web
Terminal and their username and password so that they can log in and begin signing up for shifts.
Manually schedule volunteers
Open the saved schedule you created by clicking on the Schedules pane on the left hand side of VSP's
main screen, selecting the schedule, and then clicking the “Open Schedule” button. Then click on a day
in the calendar view that contains some shifts. Click on one of the empty positions in the shift and
you'll see that the volunteer list on the right side of the window shows the volunteers that are eligible
and available to fill the selected position. VSP displays volunteers with scheduling conflicts in red and
orange. For example, if a volunteer is already scheduled at that shift, his name will appear red to warn
you not to schedule him in the selected position. To fill the position with one of the volunteers in the
list, double click or drag and drop the volunteer to assign them.
Set up repeating assignments
After the volunteer has been placed in the empty position, you'll see a “Repeats...” bubble appear that
points to the assignment. By clicking on that bubble, you can set up that assignment to repeat on a fixed
pattern (e.g. every weekday, every 3rd week, etc.) You'll use this “Repeats...” bubble extensively if you
are using the fixed rotation scheduling model.
Allow the auto-scheduler to fill positions
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If you are using the availability based rotation model, you'll use the auto-scheduler to automatically fill
positions based on your volunteers’ availability and preferences by clicking the “Auto-schedule” button
in the upper right corner of the schedule window. The auto-scheduler will ensure that volunteers are not
scheduled during any of their “Unavailable times”, that their shift preferences and preferred serving
frequency settings are honored and that each volunteer appears on the schedule regularly.

Step 5: Customizing VSP for your organization
Now that you've seen how to fill the shifts in your schedule, let's see how you can customize VSP for
your organization.
Custom Fields
If you need to collect and track volunteer information that is not reflected in the predetermined fields
within VSP, you can create custom fields (note: custom fields are only available in VSP’s Standard
Edition). Examples of common custom fields include t-shirt size, birthday, certifications, and more.
You can add your custom fields to the enrollment form and the My Profile form so that volunteers can
update these fields themselves online.
To define custom fields in VSP, go to the Volunteers pane and click “New Volunteer…” In the new
window, click the “Edit Custom Fields…” button that you will see in the lower left portion of window.
A new window will open and in the upper right side, click the “Create new field” button. You have
different options for custom fields: text, number, date, checkbox, and list of options. Once you create
the field it will appear in the main part of the screen. Click OK once you have added all the custom
fields you wish to track.
Web Terminal Settings
Click on the Web Terminal pane on the left hand side of VSP's main screen and then click the “Web
Terminal Settings” button at the top of the Home tab. In the dialog that appears, a variety of
customization options are available (note that the options in the Web Terminal Settings dialog are not
accessible during VSP’s 15 day free trial). Among many other options, you can:
•
•
•
•
•

Customize the text of automatic email reminders
Turn on automatic text message (SMS) reminders
Turn on automatic processing for web forms, so that requests that volunteers make through the
Web Terminal are processed immediately, instead of being held for manual processing.
Brand the Web Terminal with your organization's logo.
Customize the profile information that volunteers can update in the “My Profile” tab. For
instance, hide the shift preferences and unavailable times areas, or include custom fields on the
My Profile tab.

Take a look through these options to get a feel for the customization options that are available, and
choose the settings that best fit the needs of your organization. By using the “Login as...” button at the
bottom of the Web Terminal pane, you can see how your changes are reflected in the Web Terminal. (If
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your changes didn’t appear to update, you may need to click the “Commit Changes” button in the lower
right hand corner of the Web Terminal pane of VSP.)
Adjust labels for “Jobs,” “Shifts,” “Volunteers”
With VSP, you can change the labels used for Jobs, Shifts, and Volunteers to terms that are more
appropriate for your organization and its members. To edit the terms used, go to the Edit menu at the
very top of VSP and choose “Change label used for” and select the label you wish to change.

Step 6: Giving your volunteers online access to the Web Terminal
When you are ready to give your volunteers access to the Web Terminal, click on the Announcements
pane on the left hand side of VSP's main screen (note that you cannot send emails during the 15 day
free trial of VSP). Click the “Templates” button in the upper right and select “Preconfigured”. Select
one of the “Introductory email” templates to send your volunteers that will provide them with the link
to your Web Terminal home page and their personal usernames and passwords that are automatically
generated for them by VSP. Tokens enclosed in {{curly brackets}} will be replaced with the
appropriate information for each volunteer when the email is sent. (You can click on the “Preview”
button to see how the email will look when sent to each volunteer. Feel free to customize the email to
best suit your organization’s needs – you can add and remove text and tokens as needed by typing into
the text box.
When you are ready to send the email, Preview and click the Send button. Your volunteers will then be
able to login and sign up for unfilled positions, request subs, and update their profile information
through the Web Terminal. If you did not turn on automatic processing of web forms, you'll want to
review and process changes regularly by clicking the Web Forms pane on the left hand side of VSP's
main screen.
We also recommend that you post a link to your Web Terminal's home page on your organization's web
site, so that your volunteers can access their schedules by visiting your organization's site. To do this,
go to the Web Terminal pane on VSP's main screen and then click the “Copy URL” button in the top
right corner of the pane. You can send an email to your organization's webmaster and choose “Paste”
from the “Edit” menu to paste the link into the email with a request to post it on your site.

Conclusion
You’ve just seen how easy it is to create schedules, publish opportunities and fill shifts using Volunteer
Scheduler Pro. The program also contains hundreds of other features that were not covered in depth in
this Quick Start Guide. Highlights include VSP’s Announcements, hours scheduled reporting,
attendance tracking, text message blasts, and more. For an inventory and explanation all of VSP's
features please refer to the complete documentation. Please do not hesitate to contact us as questions
arise. We are happy to help you get started with VSP and make sure that all your organization's specific
scheduling needs are met.
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Appendix A: The three common volunteer scheduling models
1. The self-sign-up model
In this model each volunteer picks their own shifts on a first-come, first-serve basis. This is the
simplest and most flexible scheduling model from the volunteer's perspective. The self-sign-up model
works best for cases where filling all shifts is not a concern, shifts do not need to be distributed evenly,
and you do not want to ask for a minimum level of commitment from volunteers.
2. The fixed rotation model
In this model each volunteer has a fixed schedule that repeats daily, weekly, or monthly. Each volunteer
is expected to work at their regularly scheduled times. In some organizations, before each schedule is
created volunteers may submit any dates on which they will not be available and are left off the
schedule on those dates. Other volunteers then can sign up for the empty positions or you can manually
schedule the open positions caused by such gaps in the rotations.
This scheduling model guarantees that all volunteers participate regularly, so it can lead to greater total
volunteer hours compared to the self-sign-up model. As the number of volunteers and shifts grow, it
becomes more difficult to manage the fixed rotations. The fixed rotation model is best used if you want
to ask for a minimum level of commitment from volunteers, the number of volunteers and shifts is
relatively small, and volunteers' schedules are consistent.
3. The availability based rotation model
In this model each volunteer is scheduled regularly, but their schedule changes from week to week
based on availability. As with the fixed rotation model, schedules are usually produced for a month or
two at a time, and before each schedule is created volunteers submit any time periods for which they
will not be available. They may also update a list of their preferred shifts, and the approximate
frequency with which they would like to serve. A schedule is subsequently assembled that honors
volunteers' requests while filling all shifts.
Like the fixed rotation mode, this model guarantees that all volunteers participate regularly, so it can
lead to greater total volunteer hours when compared with the self-sign-up model. It also ensures that all
shifts are filled (given sufficient volunteers), in contrast to the other two common models. The
availability based rotation model is best used if you want to ask for a minimum level of commitment
from volunteers and volunteers' availability is not consistent.
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